# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>Advantages of an Honors Thesis</td>
<td>3</td>
</tr>
<tr>
<td>Types of Thesis Projects</td>
<td>3</td>
</tr>
<tr>
<td>Timeline for the Honors Thesis</td>
<td>4</td>
</tr>
<tr>
<td>Your Thesis Committee</td>
<td>4</td>
</tr>
<tr>
<td>Selecting a Thesis Topic</td>
<td>5</td>
</tr>
<tr>
<td>Application for Honors Thesis</td>
<td>6</td>
</tr>
<tr>
<td>Registration for the Thesis Course</td>
<td>6</td>
</tr>
<tr>
<td>Parts of the Thesis</td>
<td>6</td>
</tr>
<tr>
<td>Manuscript Guidelines</td>
<td>7</td>
</tr>
<tr>
<td>Final Submission Process</td>
<td>11</td>
</tr>
<tr>
<td>Appendix 1: Application for Honors Thesis Form</td>
<td>14</td>
</tr>
<tr>
<td>Appendix 2: Sample Pages</td>
<td>15</td>
</tr>
<tr>
<td>Appendix 3: Thesis Checklist</td>
<td>16</td>
</tr>
</tbody>
</table>
Introduction

Congratulations! You have arrived at an important milestone in your pursuit of an honors degree at The University of Memphis: writing your Honors thesis. The process of writing a thesis may be one of the most rewarding, yet challenging experiences of your education thus far. In fact, the honors thesis is the culmination of an Honors curriculum at The University of Memphis and epitomizes Honors education. In close consultation with a faculty member, you will undertake a major research project or creative experience appropriate to a serious undergraduate program.

This handbook summarizes the requirements and procedures for completing an honors thesis. Much of the handbook contents—ranging from the selection of your thesis topic and your advisor to the preparation of the final manuscript—are included in response to the many questions that the Honors staff have received from students. This guide should answer your questions about thesis preparation. If you have specific questions that are still not answered, please contact the Honors office at (901) 678-2690.

The Advantages of an Honors Thesis

Although undertaking thesis research is hard work, most students report that the thesis is one of their most prized academic achievements. Professors who work with students on the honors thesis can write meaningful letters of recommendation and may be able to place students in contact with colleagues at other schools or companies. Moreover, graduate schools frequently require writing samples as part of the application process, and an honors thesis frequently serves as the centerpiece for your application for awards, scholarships, or graduate or professional study.

In conjunction with your undergraduate degree, the honors thesis signals to potential employers and prospective graduate schools that you have the maturity of intellect that will be applicable to whatever profession you choose. Your honors thesis provides ample evidence of your ability to pursue independent initiatives and to make a contribution to your profession.

Types of Thesis Projects

In general, honors theses fall into two categories:

- For students in the liberal arts or laboratory sciences, the thesis may be a written piece of work. But writing a thesis differs from writing simply another research paper for two reasons. First, an honors thesis usually entails producing a work that is about 30-40 pages long, although some—particularly in math and the laboratory sciences—may be shorter. Second, the thesis should contain original insight into a discipline or body of knowledge. The honors thesis should go beyond merely summarizing the existing research and include a student's own critical and creative thinking.

- For students in majors such as drama, art, music, film, or engineering, the honors thesis may be a creative endeavor appropriate to the discipline. For example, an art student might create an exhibition of original works, a film student might produce a documentary, a creative writing student might write a collection of short stories, or an engineering student might design a prototype. If the honors thesis is a creative work, a substantive written description (approximately 15 pages) must accompany the project, detailing how the creative work meets the goals of a thesis.

Examples of past theses include:

- Critical or textual analyses
- Creative writing projects (e.g., portfolio of short stories or poems)
- Business plans
- Teaching portfolios
• Laboratory or field experiments
• Creative performances or exhibits
• Original creative products such as a Web site, musical composition, etc.

**We recommend that you view the honors thesis as a two-semester, six-credit project.** In the first semester of your senior year, you should enroll in directed research or independent study; in the second semester, you should enroll in honors thesis hours. Some departments offer an honors senior thesis which will satisfy the thesis requirement in the University Honors Program. If a department does not have such a course, then you will need to enroll in UNHP 4999 Honors Thesis.

If you do choose to write your thesis in one semester, plan ahead! A good background on the subject will give you the running start that you need to complete the thesis in one semester.

**Timeline for the Honors Thesis**

The following timetable is offered as a guideline. Students are recommended to begin the thesis research (UNHP 4900 Advanced Honors Projects or an equivalent course in the major department) in the fall of the senior year and complete the thesis (UNHP 4999 Honors Thesis or an Honors Thesis course in the major department) in the spring of the senior year.

<table>
<thead>
<tr>
<th>Event</th>
<th>Timeframe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a topic</td>
<td>Second semester of junior year</td>
</tr>
<tr>
<td>Approach faculty members about mentoring and reviewing</td>
<td>Second semester of junior year</td>
</tr>
<tr>
<td>Register for UNHP 4900 Advanced Honors Project (a permit will be issued when application is approved) or register for an honors directed study in another department.</td>
<td>First semester of senior year</td>
</tr>
<tr>
<td>Submit draft (or sufficient work worthy of 3 hours of research credit to the faculty mentor for approval. Faculty member will assign a grade for the course.</td>
<td>Last class day or equivalent</td>
</tr>
<tr>
<td>Submit Application for Honors Thesis form to the Honors Program.</td>
<td>Prior to registering for UNHP 4999 Honors Thesis or equivalent course in another department. Form MUST be submitted before the last day to add a class in the graduating semester.</td>
</tr>
<tr>
<td>Register for UNHP 4999 Honors Thesis (a permit will be issued) or an honors thesis course in another department.</td>
<td>Second semester of senior year</td>
</tr>
<tr>
<td>Submit final copy of the project to the Honors Office to be certified to graduate with University Honors.</td>
<td>Not later than study day of the semester you are enrolled in an Honors Thesis course.</td>
</tr>
</tbody>
</table>

**Your Thesis Committee**

In most cases, the thesis committee will consist of a **thesis advisor**, who will monitor your progress and grade your work, and another professor who serves as a **second reader**. Thesis advisors must be full-time, tenure-track faculty members at the University of Memphis, but second readers do not have to be full-time faculty members. Some departments (like English) may require more than two
Thesis Advisor. Selecting your thesis advisor is one of the most important decisions that you will make during this process. Because you will have to work with this person closely for at least a semester, you should consider both the professor’s expertise and the potential for a close working relationship. The two of you must be able to communicate well and cooperate on your endeavor, because you will rely upon your advisor for help, encouragement, and support.

The thesis advisor acts as your guide through the process of completing an honors thesis. The advisor will work with you to refine your interests into a suitable thesis, help you to identify a second reader, meet with you regularly (every two weeks is recommended), and read and comment on drafts of the thesis as it develops.

Many students select a thesis advisor from a class or independent study and can connect their thesis topic to work they have already done with the professor. Other students may know that a certain professor shares their research interest, but they may not have been enrolled in a course with him or her. In either case, make an appointment with the professor to discuss your research topic and your desire for that person to serve as your thesis advisor. If you don’t know the professor personally, be prepared to present your qualifications.

It is not unusual to speak to several faculty members before finding the right person to direct your thesis. If a professor you visit is too busy or feels unqualified to be your thesis advisor, ask the professor to suggest colleagues who may serve as your advisor. Your departmental advisor or the departmental Honors coordinator may also be a good source of information about faculty members who have similar interests to yours or who have served as thesis advisors in the past.

As you approach a faculty member about being your thesis advisor, please explain that the University Honors Program thesis requirement is the baccalaureate-level equivalent of the master’s thesis for that area of study. While honors students are not expected to produce the equivalent of a master’s thesis, they are expected to engage in a research project or creative endeavor that approaches a master’s thesis in length and scope, using the same research methods and skills.

Second Reader. Some academic departments require a second professor to serve on your thesis committee as a “second reader.” This committee member is responsible for providing guidance to you where appropriate, meeting with you occasionally, and reading and commenting on drafts of the thesis in later stages of its development. If you do not already have a professor in mind as your second reader, your thesis advisor can usually recommend someone.

While you should have a general idea of your thesis topic, it is not necessary to have a definitive proposal before forming your thesis committee. In fact, your committee will probably help you to refine your research interests so that you will be on track to developing a “doable” thesis project.

Selecting a Thesis Topic

Think about topics in your course work that interested you. Are there any particular topics that piqued your interest? You may want to review the courses you have taken as an undergraduate and/or review papers that you have written, because a thesis topic often emerges from classes, directed studies, or internship experiences.

Alternatively, perhaps you have a particular professor in mind who you think would make an ideal thesis advisor. Schedule an appointment with this professor to talk about his or her research interests. Often thesis topics emerge from a faculty member’s ongoing research projects, especially in the sciences where students are involved in laboratory work.
Keep in mind that you will be working on this project for a semester or even an entire year. Thus, it is important that you choose a topic that will hold your interest for this period of time.

**Application for Honors Thesis**

The Application for Honors Thesis form must be filed with the Honors Program office by the third Friday of the semester in which you are enrolled in an honors thesis. Prior to submission to the Honors Program office, the application should be approved and signed by the faculty member responsible for directing the senior honors thesis, and by the departmental honors coordinator if applicable. The Application for Honors Thesis form MUST be submitted to the Honors Program in order for a student to be certified to graduate with the designation of “University Honors with Thesis.”

The Application for Honors Thesis form is located in Appendix 1.

**Registration for the Thesis Course**

You must have the approval of the faculty member who serves as the thesis director to register for a thesis course. **All Honors Program students must enroll in a thesis course.** You will need to register for your honors thesis course (UNHP 4999 or an equivalent honors thesis course in your department) during the semester you actually write your thesis.

**Parts of the Thesis**

The following is the standard format for an Honors thesis or project paper.

**Title Page:** All copies must contain a title page. The title page must contain the title of the thesis, the statement of submission, the name of the candidate, the name of the University granting the degree, and the year the degree is to be granted. *See Appendix 2.*

**Dedication Page:** This optional page is used if you wish to honor someone who has significantly influenced your life or career. Dedications are typically short; for example, “This thesis is dedicated to my mother and father.”

**Abstract Page:** The abstract is a brief, comprehensive summary of the contents of the thesis. It should state the problem, describe the procedure or methods used, and summarize the conclusions reached. The body of the abstract should be no longer than 150 words, double-spaced. Your name, degree to be conferred, university, month/year degree will be conferred, the thesis title, and name of thesis advisor should appear at the top of the page. *See Appendix 2.*

**Acknowledgments:** This optional page is where special help received (guidance from your committee members, funding agencies, relatives, etc.) should be acknowledged.

**Table of Contents:** The table of contents reflects the outline and organization of the thesis. The main body of text (and corresponding sections or chapters), bibliography, appendix material (if any), list of tables (if any), and list of figures (if any) should appear in the table of contents. Preliminary pages (e.g., acknowledgments, dedication, etc.) are not included. *See Appendix 2.*

**Lists of Figures and Tables:** If five or more figures (or five or more tables) appear in the main body of text, you must include a list of figures (or tables) after the table of contents. Each legend must appear in the list exactly as it appears in the text (same wording, same figure/table numbers). *See Appendix 2.*
Manuscript Guidelines

Honors students are expected to follow the style requirements for their fields (e.g., APA style for social sciences or MLA guidelines for humanities). Consult with your thesis advisor for a recommended format. Below are some general recommendations:

FONT AND POINT SIZE

- Arial or Times New Roman
- 12-point font size

MARGINS

- 1.0" top, right, and bottom
- 1.5" left

MARGIN JUSTIFICATION AND HYphenATION

- Align text with the left-hand margin, except for paragraph indentations, centered headings, or block quotes. Full justification of margins is not acceptable; the right-hand margin must be jagged.
- Hyphenation at the right-hand margin is allowed as long as it does not cause difficulty in reading.

SPACING

- Double space your text; however, you may single space data in long tables, quotations more than 4 lines in length, footnotes (double space between each entry), multi-line figure captions, and bibliography or reference entries (double space between each entry).
- Triple space before and after all tables and figures within the text.
- Do not begin any subheading or other divisions on separate pages. If a subheading falls at the end of a page, move it to the top of the next page unless at least two lines of text can follow the subheadings on that page.

MANUSCRIPT ORGANIZATION

- Recommended page order is: title page; dedication page; acknowledgments; abstract page; table of contents; list of tables; list of figures; body of thesis; bibliography/references; appendix.

PAGE NUMBERING

- All page numbers should stand alone without any form of punctuation.
- The preliminary pages (e.g., the Dedication, Acknowledgment, Abstract, Table of Contents, etc.) are numbered in lower case Roman numerals (ii, iii, and so on). They should be centered at the bottom of the page.
- The Title Page is not numbered. It is understood to be page Roman numeral i, although the number does not appear on the page itself.
- The main body of the text, including references, is numbered with Arabic numerals. They should be centered at the bottom of the page.

<table>
<thead>
<tr>
<th>Pagination and Sequencing Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Order</strong></td>
</tr>
<tr>
<td>Preliminary Pages</td>
</tr>
<tr>
<td>Title Page</td>
</tr>
</tbody>
</table>
Dedication (optional) | Count/Number | Center Bottom | No
Acknowledgments (optional) | Count/Number | Center Bottom | No
Abstract | Count/Number | Center Bottom | No
Preface (optional) | Count/Number | Center Bottom | No
Table of Contents | Count/Number | Center Bottom | No
List of Tables (for 5 or more only) | Count/Number | Center Bottom | Yes
List of Figures (for 5 or more only) | Count/Number | Center Bottom | Yes

<table>
<thead>
<tr>
<th>Text</th>
<th>Arabic Numbers Starting at 1</th>
<th>Location</th>
<th>Yes/No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Count/Number</td>
<td>Center Bottom</td>
<td>Yes</td>
</tr>
<tr>
<td>Thesis text</td>
<td>Count/Number</td>
<td>Center Bottom</td>
<td>Yes</td>
</tr>
<tr>
<td>Summary or Conclusions</td>
<td>Count/Number</td>
<td>Center Bottom</td>
<td>Yes</td>
</tr>
<tr>
<td>Recommendations</td>
<td>Count/Number</td>
<td>Center Bottom</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Reference Pages

| Bibliography/References | Count/Number | Center Bottom | Yes |

**SAMPLE PAGES (in sequence)**
- Title page
- Dedication (optional)
- Acknowledgments (optional)
- Abstract Page
- Table of Contents

**ABSTRACT**
- The abstract should be the last part to be written. It must show the reader both the context and content of the work and must include the purpose of the work, including any hypothesis to be tested or major question asked; the approach used; the main findings; and the conclusions.
- The abstract must **NOT** include internal headings or any author citations.
- Mathematical formulas, diagrams, and other illustrative materials must be avoided at all costs.
- Honors students must prepare an abstract 150 words or less, doubled-spaced.
TABLE OF CONTENTS

- The Table of Contents must reflect the outline and organization of the thesis.
- Headings included in the Table of Contents must be worded exactly as stated in your document.
- Make sure page numbers correspond to the text.

MANUSCRIPT TEXT

Main Body (if appropriate to your discipline, the following format should be used; otherwise, adhere to the guidelines in the style manual or journal preferred by your department.)

- Introduction. The introduction should contain a clear statement of the purpose or hypothesis to be tested, an overview of the problem or subject as it is known from the literature, and a broad statement summarizing the findings.
- Literature review. The literature review should be a comprehensive discussion. It should provide a unique and valuable reference resource for other scholars in your field.
- Statement of research objectives (if not explicitly stated in the introduction). This statement should consist of specific objectives to be addressed by the research published in the thesis.
- Body of the work (methods and materials, results, and discussion in scientific disciplines).
- Overall conclusion (if not explicitly stated in the discussion). The discussion or last chapter or section should be followed by an overall conclusion. This section should include a brief restatement of your conclusions presented in the body of the text.
- Bibliography or Reference section. The bibliography or reference section should appear in one location at the end of the thesis BEFORE any appendices (unless specified differently in a scientific discipline) and should include ALL cited references. Citations should be listed alphabetically and should conform to a single format that is accepted as standard within your discipline. Avoid breaking bibliographic entries onto a following page. Separate bibliographies for each chapter are NOT acceptable.
- Appendices (if needed). The majority of the materials included should represent the work of the student. The format may include individual tables and/or figures with legends, text alone, or whole chapters. The same format rules that apply to the text of the thesis must also apply to all appendices. References included in the appendices must be included in the comprehensive bibliography or reference section.

REFERENCES/BIBLIOGRAPHY

- Cite all references in the text; reference all citations.
- Be consistent in the referencing style used (APA or MLA).

CITING ELECTRONIC OR ONLINE SOURCES

Most style guides include some information about how to cite electronic media or publications. The APA and MLA manuals all include several pages devoted to online sources.

TABLES AND FIGURES

- All tables and figures, including the caption, must meet margin, font, and format requirements.
- Triple space before AND after all tables and figures within the text.
- The number of a table and its corresponding caption must be typed ABOVE the table. Use Arabic numbers and single space the caption.
- The number of a figure and its corresponding caption must be typed BELOW the figure. Use Arabic numbers and single space the caption.
- The figure caption must appear on the same page as the figure; the figure may be reduced (but still readable) to accommodate the caption.
- If a table and/or figure is continued onto another page, repeat both the table or figure number, title, and table header row. Use this standard table format unless your journal specifies otherwise. Do NOT show full grid lines within the actual table, the only lines in a table should be the ones above and below the header row and at the bottom of the table.
- All diagrams, drawings, and figures must be clear, sharp, and large enough to be readable. Color figures, illustrations, or charts may be submitted.
• Tables and/or figures one half page or less in length must appear on the same page with text either above or below. If a table and/or figure is larger than one half page, it should be inserted on a single page.
• Two small tables or figures should be placed together on a single page, with a triple space (or 2 double spaces) between them.
• Extra-wide tables or figures should be placed in landscape orientation (broadside). The table number and title should be closest to the 1.50” left margin AND the page number should also be placed in landscape orientation.
• Honors students may place tables and/or figures in the body of the text or in a separate appendix UNLESS several tables and/or figures are listed together and interrupt the flow of the text, then they MUST be put in a separate appendix. If tables and/or figures are placed in a separate appendix, please be sure to reference this information in the text.

LIST OF TABLES (Required for 5 or more)
• A separate page (inserted after the Table of Contents) must be titled LIST OF TABLES.
• Single space each table title more than one line in length and align the wrapped text with the text on the next subsequent line.
• Double space between each title entry.
• The wording of the titles must be consistent with your document.

LIST OF FIGURES (Required for 5 or more)
• A separate page (inserted after the List of Tables) must be titled LIST OF FIGURES.
• Spacing requirements and the wording of titles are the same as the List of Tables.

RUNNING HEADERS/FOOTNOTES/ENDNOTES
• Running headers and endnotes are NOT allowed for honors theses.
• If footnotes are used, they must conform to margin requirements. They must also begin on the page they are cited. The font size, however, may be one size smaller than the text. Indent the first line of the footnote, and then flush each subsequent line with the left margin. Double space between each footnote entry.
• Footnotes are NOT to be numbered consecutively throughout the text. Begin each footnote number with the Arabic number “1” at the beginning of each new chapter.

WIDOWS AND ORPHANS
A thesis will not be accepted if it contains “widows or orphans”. Widow lines occur when the last line of a paragraph appears alone at the top of a page. Orphan lines occur when the first line of a paragraph appears alone at the bottom of a page.
• A subheading at the bottom of a page must have two lines of text below it. Otherwise, the subheading should begin at the top of the next page.
• A new paragraph at the bottom of a page, must include two lines of text. Otherwise, the entire paragraph should begin at the top of the next page.
• When ending a paragraph at the top of a page, there must be at least two lines of text.
• You may allow more than 1” at the bottom of a page in order to avoid widows and orphan lines.

MATHEMATICAL EQUATIONS
• Include a triple space before and after all mathematical equations.
• Equation numbers must be aligned with the right-hand margin.

IMAGES
• All images (color or grayscale) included in your document must be clearly readable both onscreen and when printed.
• The format embedded in the PDF version should be EPS (Encapsulated PostScript) files rather than bitmaps, GIFs or JPEG images.
• Larger images, including maps, plates or charts, which require high resolution must not be included in the main document. They must be uploaded as “supporting files” in the ETD system.
Final Submission Process

The University of Memphis hosts an electronic repository for theses submitted to the Helen Hardin Honors Program, and electronic submission of the final honors thesis is now a requirement to earn the “University Honors with Thesis” designation at graduation. This section of the thesis manual is intended to assist you in submission of your thesis document.

EMBEDDING DOCUMENT FONTS
All document fonts must be embedded. Embedding fonts simply means that your font information used to create your document will always look the same way it does when stored in a PDF file. If fonts are not embedded, Adobe Acrobat will substitute fonts on a reader’s computer, which can result in a loss of formatting.

a. How to Embed Fonts Using Microsoft Word 2010 on a PC:
   - You will need to first visit Word Options. To get there, click the File tab > Options > Save, and make sure that “Embed fonts in the file” in the textbook is checked.

b. How to Embed Fonts Using Microsoft Word 2007 on a PC:
   - Create your manuscript using one of the fonts mentioned above (preferably Times Roman).
   - Click the circular Office Button in the upper left-hand corner of Microsoft Word.
   - A new window will open. In the bottom right-hand corner is a button called Word Options. Click that button.
   - Choose Save from the left sidebar.
   - Check the box next to Embed Fonts in the file.
   - Click the OK button.
   - Save your document.

c. How to Embed Fonts in Earlier Versions of Microsoft Word:
   - Create your manuscript using a TrueType font.
   - On the Tools Menu, choose Options.
   - Click the Save tab.
   - Select the Embed TrueType Fonts check box.
   - Save the document.

c. Using Microsoft Word on a Mac using Word 2011:
   - Convert your document to PDF.
   - Open the original PDF in the Preview application of your Mac.
   - Select File: Print
   - Click on the Preview button - a new document should be generated.
   - Select File: Print again (you should be in the newly-created document when you do this).
Click the PDF button, and then select Save as PDF...from the pop-up menu.

Choose a filename and save the file; the file you just saves should have all of the fonts embedded.

INSTRUCTIONS FOR ELECTRONIC SUBMISSION

Log into the U of M ETD site at: https://umwa.memphis.edu/ht

Click on the My Submissions tab.

Log in using your U of M UUID username and password.

Choose the + Add New ETD option.

At the top of the front matter page, you will be able to set an access level:

--Unrestricted - open to anyone with Internet access.

-- Restricted- The author allows access only while on the University of Memphis campus and current University of Memphis faculty, staff or students who authenticate from off-campus.

-- No Access - Due to patents included or other intellectual properties, the author has chosen not to make their work available online.

Your e-mail address and name will automatically populate (if this information is incorrect, please call 901-678-8888 or go to your account at my.memphis.edu to update your University records). You MUST use your U of M e-mail account during the electronic process.

To complete the remainder of the form, you will need to have the following information handy:

- the names and e-mail addresses of your committee members;
- the exact title of your document, which must be entered using BOTH uppercase and lowercase letters (no ALL uppercase letters, please);
- up to 10 keywords that describe your document's contents for search engines;
- and the exact abstract from your document - 350 words or less for dissertations; 150 words or less for theses.

Do not copy and paste your Word document abstract into the text box. Please type from scratch; remove the "header" paragraph containing your name, degree, university, date conferred, title, etc. The entire abstract must be single spaced; however, indent seven spaces at the beginning of each new paragraph. The font type and font size must be Arial, 12 point.

Complete as much of the form as you want and then select Add.

When you access the form a second time, you will be asked to Save rather than Add. DO NOT ADD A NEW FORM TO THE SYSTEM. Work with your original submission.

After the font matter has been completed, upload your document and any supporting files. Your document must be a single PDF file and must include all figures, graphics, and tables; you may submit up to 6 audio/visual supporting files.

Once your document has completely uploaded, click the Submit button. Your document will be sent to the ETD manager in the Honors Program for final approval. Once you submit, you will NOT be able to change your file. (NOTE: If you do not click the Submit button, your document will go to the "In Progress" queue and will never be submitted to the Honors Program).
• You will receive e-mail notification once your document has been opened for review by the ETD manager. **Notification will be sent only to your U of M e-mail account.**

• If your document is not approved, you will receive e-mail notification of further needed changes.
  
  • Make these changes in the original version of your Word document. Convert once again to PDF format, connect to the ETD web site, and log in.

  • Click **View** to get to your document; click **Edit** and **Delete** the previously uploaded file (look for a "Trash Can" icon at the bottom of the form). **Add** your revised document, then click **Submit** again.

You will receive e-mail notification when your document has been approved by the ETD manager. Your document on the ETD server will be available immediately for public viewing, depending on your requested access level (**see next section**).
APPENDIX 1: HONORS THESIS FORM

Application Form for Honors Thesis

Semester/Year

Name of Student (please print) ____________________________

Major

Student ID (“U-Number”) ____________________________

Email Address

Proposed Thesis Title ____________________________

Department ____________________________

Course # ____________________________

Thesis Advisor (please print) ____________________________

Expected Completion Date ____________________________

Graduation Date ____________________________

For thesis proposal approval, please obtain the following signatures:

Student Signature ____________________________ Date: _________________

(Highlighted signature)

Honors Project Advisor ____________________________ Date: _________________

(Highlighted signature)

Departmental Honors Coordinator Advisor (if any) ____________________________ Date: _________________

(Highlighted signature)

Honors Program Director ____________________________ Date: _________________

(Highlighted signature)
Abstract

The current study investigated potential relationships between women’s physical attractiveness, body size and shape, and self-esteem. Young college women (N = 120) completed questionnaires and were weighed, measured, and rated for physical attractiveness. Results revealed that self-esteem was unrelated to physical attractiveness and general body dissatisfaction. Explanations for this null finding are considered.

List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Demographics of Participants</td>
<td>19</td>
</tr>
<tr>
<td>2. Summary of Participant Characteristics</td>
<td>20</td>
</tr>
<tr>
<td>3. Scale Items on Self-Esteem Measure</td>
<td>21</td>
</tr>
<tr>
<td>4. Mean, Standard Deviation and Simple Correlation Between Body Size and Ratings of Attractiveness</td>
<td>30</td>
</tr>
<tr>
<td>5. Mean, Standard Deviation, and Simple Correlation Between Body Size and Self-Esteem</td>
<td>32</td>
</tr>
</tbody>
</table>
APPENDIX 3: THESIS CHECKLIST

MARGINS: 1.50” on left side, 1” on all other sides

ORGANIZATION:

_____ 1. Title Page
_____ 2. Dedication Page (Optional)
_____ 3. Acknowledgments (Optional)
_____ 4. Abstract
_____ 5. Table of Contents
_____ 6. List of Tables (only for 5 or more)
_____ 7. List of Figures (only for 5 or more)
_____ 8. Body of Thesis (divided into chapters or sections)
_____ 9. References/Bibliography
_____ 10. Appendix or Appendices

FONT AND POINT SIZE: 12-point Arial or Times New Roman

PAGINATION:

_____ All pages, except the Title Page, should be assigned a number.
_____ The preliminary pages (front matter) are numbered in lower case Roman numerals (ii, iii, and so on). The Title page is assumed to be page i, but is not numbered.
_____ The main body of text, bibliography, and appendices (if any) are numbered with Arabic numerals.
_____ Page numbers should be centered at the bottom of the page (including all preliminary pages).

SPACING:

_____ Text must be double-spaced.
_____ Tables, long quotes, and bibliography/reference listings may be single-spaced.

TABLES/FIGURES:

_____ Table/Figures must be identified in the text by a number.
_____ Table number and title must be typed above table.
_____ Figure number and caption must be typed below figure.

REFERENCES/BIBLIOGRAPHY

_____ References should appear before any appendices.
_____ References should include all citations.
_____ Citations should be listed alphabetically and should conform to a single format (MLA or APA).